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1. Introduction to Mnova Binding  

In this Starting Guide, we will give you a brief overview of the main steps and functions available in Mnova 

Binding, which has been designed to carry out the quantitative chemical shift perturbation (CSP) analysis of 

1D and 2D NMR titrations.  

Mnova Binding deals with 1D and 2D NMR (typically HSQC-type) titration experiments where the target 

molecule (the receptor) spectrum is monitored in both the absence and the presence of increasing 

concentrations of a given species (the ligand) that binds to the receptor. The analysis of the CSP, as conducted 

according to the peaks of the receptor spectrum through the titration, provides quantitative information 

about the strength of the receptor-ligand interaction by means of the dissociation constant (KD). In this way, 

for each peak selected, Mnova Binding tracks the peak movement, generates a binding curve (CSP vs. the ratio 

of ligand/protein concentration) and computes the associated KD. With the individual KD calculated for each 

peak, Mnova Binding performs statistical analyses to retrieve a single “representative” KD based on a weighted 

average function. Mnova Binding allows the user to perform an initial curve fitting to a simple 1:1 model and, 

in a second step, a more sophisticated analysis is possible by exporting the curves to the AFFINImeter-NMR1 

module.   

The main characteristics of the software include:  

• Automated and manual peak tracking along the titration spectra.  

• For each peak tracked, automatic generation of the corresponding binding curve and KD calculation. 

• Automatic calculation of average KD. 

• Semi-automated detection of “bad” KD values and their exclusion from the calculation of the average 

KD.  

• Easy inspection of results, peak by peak.  

• For a given target receptor, performs automated analysis of multiple titrations (for instance, involving 

different ligands), working in batch mode.   

• Data exportation to the AFFINImeter-NMR module for an advanced and in-depth analysis. 

• Saving and reporting of the analysis results. 

Following in this Starting Guide, we will introduce you the main steps to the CSP analysis in Mnova Binding. 

 

 

 

 

 

 

 

 

 

 
1 AFFINImeter NMR is a functionality of Mnova Binding developed by the Company Software 4 Science Developments. 
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2. The Mnova Binding Panel 

Before you start an analysis in Mnova Binding, the titration spectra must be loaded in an Mnova document, 

superimposed on the same page. Then, you can go to the Mnova Binding tab located in the main ribbon under 

“Binding”. 

 

 

This panel contains several options: 

 

 

 

 

 

These options allow you to perform a manual or automated CSP analysis. In the following sections, we explain 

both approaches and how to export the binding curves to AFFINImeter-NMR in greater detail.  

3. Manual Chemical Shift Perturbation Analysis  

3.1. Superimpose the titration spectra in Mnova  

There are different approaches to superimposing the titration spectra in Mnova, as described in the Mnova 

Manual. This section explains two of these approaches: 1) manually, by loading the spectra into Mnova and 

using the options in the tab “Stacked”, and 2) automatically, by using the “Import Directory Spectra Stack” 

script available in Mnova’s Script tools section. 

3.1.1. Manually 

To superimpose the spectra manually, you need to import them into the same Mnova document (e.g., by 

dropping your raw data into Mnova). Once the relevant data has been imported, the spectra are automatically 

processed and individually displayed on different pages of the Mnova document.  

Binding Panel    

New analysis  

Properties 

Manual Peak Selection  
Imports Peak List 

Select Peak Series 

CSP table  

Tool for batch-mode Automated Analysis 

Send curves to 

AFFINImeter 

Import spectrum peaks 

https://mestrelab.com/downloads/mnova/manuals/MestReNova-14.2-0_Manual.pdf
https://mestrelab.com/downloads/mnova/manuals/MestReNova-14.2-0_Manual.pdf
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In the “Pages” window, select a page and right click with the mouse to use the option “Select All” (or press ctrl 

+ A), which selects all the pages of the document. Use the “Superimpose Items” option in the Stacked tab to 

superimpose the spectra on the pages selected. The superimposed spectra will be displayed in a new 

document page.  

 

Drag and drop the folder containing 

the raw data set into Mnova. 

Select all the spectra 

from the Pages window.  
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3.1.2. Automatically 

Use the “Import Directory Spectra Stack” script available in Tools > Script Tools > Import > Directory Spectra 

Stack. The Import Spectra Stack window that appears contains fields to gain the titration spectra from the 

folders where they are located, and options to set the final display of the spectra in the Mnova document. For 

subsequent use in Mnova Binding, use the “Superimposed” option. Additionally, you can include the path to 

a processing template file to apply defined processing to all the spectra involved in the titration. When the OK 

button is clicked, Mnova loads the spectra and automatically creates a document with a single page with the 

spectra superimposed.   

The Stack menu appears when 

several spectra are selected  

Click on the Superimpose Items 

button of the Stacked tab.   

A new page with the 

superimposed spectra 

is created.    
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3.2. Peak tracking 

To begin the analysis, click on the “Show Table” button of the Mnova Binding menu to display the Chemical 

Shift Perturbation dialog. Then, click on “New” to start a new analysis project. In the General tab, a table with 

the list of superimposed spectra is shown, where the concentrations of the Receptor (Pt) and the Ligand (Lt) 

must be entered. An additional column giving the Lt/Pt concentration ratio is also included in this table. When 

the concentrations are added, appropriate options to track peaks are activated.  

Complete the Data Folder and 

Processing Template boxes in the form  
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There are different ways to track the peaks: 

3.2.1. Manual peak tracking: 

• Click on the “Select peak” button and then click with the left mouse button on one peak of the first 

spectrum (ligand concentration = 0). Mnova Binding will then identify and track the analogous peak in 

the other spectra.  

• Alternatively, after clicking on the desired peak with the left mouse button, you can hold down and 

drag the cursor in the direction in which the peak is moving.  

 

Table with the protein 

and ligand concentrations  

Manual peak tracking   

Import Peaks from file 

Tracked peaks 

Import Spectrum Peaks 
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A new tab “Series n” is automatically generated with information on the peak being tracked. The 

corresponding binding curve is also displayed in this tab with the curve fitted to a 1:1 binding model and the 

resulting KD value displayed. Users can also access this “Series n” tab by double clicking on the corresponding 

tracked peak in the Peaks table.  

 

3.2.2. Importing a list of peaks: 

You can import a text file with a list of peaks using the “Import Peaks From File” option. In this file, a label and 

chemical shift in each dimension of the peaks is included. The peaks in this file will be automatically identified 

and tracked.  

 

 

 

 

 

 

 

Tracks peaks listed in a txt file.  

Table with detailed information of 

the CSP in every spectrum of the 

peak tracked 
KD and σ of the peak series 

 Binding curve and fit     
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3.2.3. Importing the peaks picked in the spectra:  

If there are peaks picked in any of the superimposed spectra, the “Import Spectrum Peaks” button is enabled 

and, when clicked, the peaks picked are automatically tracked. You can find more information about the peak 

picking options in the Mnova Manual. 

 

3.3. Manual refinement of peak tracking 

Manual refinement of peak tracking is also possible by placing the cursor on the position tracked for a given 

spectrum, clicking with the left mouse button, pressing the Shift key, holding down and dragging the cursor to 

the new position (note: in order to use this functionality, the “select peak” option must be off).  

 

3.4. Binding curve generation and fitting 

The results of your analysis will be displayed in the Summary and Peaks tabs. The Summary tab reports 

information about the statistical analysis performed to calculate a single “representative” averaged KD value.  

  

Average KD 

Manual refinement of the peak tracked  

With this option, the 

peaks picked will be 

tracked automatically    

Average KD error 

Peaks tracked 

Peaks used in the average KD calculation  

% of peaks used in the average KD calculation  

https://mestrelab.com/downloads/mnova/manuals/MestReNova-14.2-0_Manual.pdf
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The Peaks tab shows a table listing all the peaks tracked, together with their individual KD values and CSPMax 

(maximum CSP at the saturation point) and respective errors, as calculated from the fitting of each curve. The 

average KD is also shown at the top of this table. In this list, it is also possible to enable or disable the peaks 

manually to include/exclude certain peaks from the calculation of the average KD. For this, use the checkbox 

next to the peak in the table. By default, Mnova Binding disables “unacceptable” results such as peaks that 

yielded negative KD values (which corresponds to a situation where the fit did not converge to a solution). 

Disabled peaks are greyed out in the table.  

 

3.5. Screening options to detect and disable “bad” results for individual fittings 

The button “Select Peaks Series” displays a dialog with various options to screen the peaks being tracked based 

on a series of filters set by the user. Here, the goal is to efficiently disable the peaks tracked when fitting does 

not fulfil the requirements set by the filters applied. The following options are available:  
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 ,  

 

 

 

 

 

 

 

 

 

4. Automated Chemical Shift Perturbation Analysis 

By clicking on the “Create from file” option, a “CSP Open” dialog containing a form is displayed. To begin the 

analysis, complete the form with the path to the folder containing the spectral dataset and, additionally, the 

paths to the following files: 

- Titrations file: text file with the receptor and ligand(s) concentration.  

- Ligands file: text file with the ligand(s) label. 

- Peaks file: text file with the location of the peaks that will be tracked (ppm for each spectral 

dimension).  

Optionally, the path to a folder in which to save the analysis report and the path to a processing template that 

will be applied to the spectral set can also be added.  

 

 

 

 

 

 

 

 

Disables peaks with lower CSPMax, making use of 

statistical functions to select these peaks  

Disables peaks yielding KD with a relative error larger than 

the value set by the user 

Disables peaks yielding KD greater than its associated error 

Disables peaks yielding negative KD (option always checked)      

Disables peaks yielding KD greater than the max ligand 

concentration used 
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See some illustrative examples of Titration, Ligands, and Peaks txt files below for the automated analysis of 

two titration datasets involving a receptor and two ligands, L1 and L2, where the labels “Ligand 1” and “Ligand 

2” are used, respectively. The Titration file for all the spectra (located in the same folder) are organized in 

titration with L1 (spectra 4, 6, 8, 10, 12, 14, 16, and 18), titration with L2 (24, 26, 28, 30, 32, 34, 36, and 38), 

and the reference spectrum (spectrum 2, receptor without ligand), is the latter being common to both 

titrations. In the first line of the document, the concentration of the receptor is specified; in the following 

lines, next to each spectrum number, the corresponding ligand/receptor concentration ratio is given. 

 

 

 

 

 

 

 

 

 

From the CSP Open dialog, a window will be displayed. Using the “Settings” button requires the appropriate 

input mask to be chosen depending on whether your titration involves 1D or 2D NMR experiments (e.g., input 

Path to folder containing 

the spectra Path to Titrations file  

Path to Ligands File  

Path to Peaks file  Path to folder where the 

Report will be saved 

Path to Processing 

Template file 

Ligands file Titrations file Peaks file 
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masks “Fid” and “ser” will recognize 1D and 2D raw NMR data, respectively). Custom input masks can also be 

used at this point. 

 

Once you have completed the form, click on “OK”. Mnova will load, process, and superimpose the spectra and 

the CSP analysis will be automatically performed in Mnova Binding based on the information provided in the 

text files.  

5. Send to AFFINImeter 

The “AFFINImeter” button exports the curves generated to the AFFINImeter-NMR module, which offers the 

possibility of performing an advanced analyses with the following options:  

- Global fitting of the entire set of curves to retrieve a single global KD value. 

- Fitting to advanced binding models that involve, for example, stoichiometries other than 1:1 and the 

participation of a third species (e.g., a competitor or a cofactor).  

If you do not find the AFFINImeter button, check in the Advanced Plug-ins dialog (File > Advanced Plug-ins) to 

ensure that the AFFINImeter-NMR plugin has been installed. If not, go to the Available tab, where it should be 

ready for installation. 

 

When clicking on the AFFINImeter button, a “Send to AFFINImeter” window is displayed. Clicking on the 

Settings button displays a dialog where you are required to include your AFFINImeter user credentials.  

 

 

 

Check that the AFFINImeter-NMR plug-in is installed 
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